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P r e f a c e  

This installation and compact instruction manual is written to be read, understood and complied with in every respect 
by persons intending to use the training system. 
 
This manual describes how to install the LabSoft Classroom Manager on a single computer (local installation) or in a 
local-area network (LAN). It is assumed thereby that such a LAN already exists and the manual does not describe the 
setting up of a LAN in any detail.  
LabSoft Classroom Manager is a supplementary administration program to facilitate the management of courses and 
users for a LabSoft installation. It is assumed that such a LabSoft installation is already in existence. 
 
The manual also advises on getting started with the program components: Editor, Manager and Reporter. For a 
detailed description of all functions and capabilities of the program, refer to the detailed online help for each of the 
components.  

This software installation manual must be read through carefully before any installation is conducted. Only the 
information in this software installation manual can prevent errors and ensure faultless operation. 

N a m e  a n d  a d d r e s s  o f  m a n u f a c t u r e r  

Manufacturer and servicing address 

 
LUCAS-NÜLLE GmbH 
Siemensstr. 2 
D-50170 Kerpen 

Tel.: +49 (0) 22 73 5 67-0 
Fax: +49 (0) 22 73 5 67-30 

E-mail: info@lucas-nuelle.com 
www.lucas-nuelle.com 
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1  L e g a l  i n f o r m a t i o n  

1 . 1  L i a b i l i t y  l i m i t a t i o n s  

LUCAS-NÜLLE GmbH accepts no liability for any damage occurring due to the following: 

 Inappropriate or incompetent use  
 Irresponsible or incorrect assembly and/or commissioning by operators or third parties  
 Subsequent modifications by operators or third parties  
 Natural wear and tear 
 Negligent or incorrect handling, servicing or maintenance 
 Actions not in keeping with the instruction manual  
 Use of inappropriate materials  

 

1 . 2  C o p y r i g h t / a u t h o r i s a t i o n  

The making of copies, including extracts, is expressly permitted to users of the training system, but only for internal 
use in connection with the operation of the equipment. 
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2  I n s t a l l a t i o n  o f  s o f t w a r e  

2 . 1  S y s t e m  r e q u i r e m e n t s  

 
PC: 

Operating system: Microsoft Windows 7, 8, 8.1 or 10 

Hardware requirements: 
As per Microsoft’s own specifications for the relevant operating system plus the following: 

• CD or CD/DVD drive for installation 

• One open USB port for USB dongle 

• At least 200 MB of free hard disc space, 1 GB recommended 

 

2 . 2  B e f o r e  y o u  s t a r t  

 

Make sure that you possess the necessary system authorisation rights to allow you to install the 
software on the computer. For the installation and subsequent use of the software you need to 
have administrator rights. If necessary, approach your system administrator to obtain the 
requisite rights needed for installation and operation. 

 

The installation of LabSoft Classroom Manager is always carried out locally on a computer, 
regardless of whether LabSoft is installed locally or on a network. If LabSoft has previously been 
installed on the same computer as that upon which LabSoft Classroom Manager is being installed, 
Classroom Manager will read all the necessary data from the LabSoft configuration file. If LabSoft 
is not already installed on the machine, the configuration file will need to be loaded after 
installation by means of the Manager program (see section 3.2 Configuration). 

 
Important note: operation of LabSoft Manager requires administrator rights. Make sure 
that you have the appropriate user authorisation. 

 

 

2 . 3  I n s t a l l i n g  t h e  s o f t w a r e  
 
1. Put the CD for SO2001-5A (LabSoft Classroom Manager) in the CD-ROM or CD/DVD 

drive of the computer. If autoplay is configured on the computer, the installation wizard will 
appear automatically. If the wizard does not appear, navigate to the CD-ROM or DVD 
drive under My Computer or Windows Explorer and open the wizard by double clicking 
the file “setup.exe” in the root folder on the disc.  
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2. Use the mouse to select the language you wish to use for your installation. The set-up 

wizard will then open. 
 
3. The following pane lets you select the mode of installation. For a standard installation 

select “Typical”. If you wish to define a specific path for the installation folder, select 
“Custom”. 

 

 
 

If “Typical” is selected for the type of installation, the program components for Classroom 
Managers are saved to the folder “C:\Program Files\LN\Classroom Manager”. If LabSoft 
itself is installed on the computer too, the LabSoft configuration file “LabSoft.config” will 
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be detected automatically. Otherwise the configuration file for LabSoft will need to be 
loaded the first time the “Manager” program is run. 

 
Important note: If an older version of LabSoft Classroom Manager is already installed on 
the computer it will be deleted as part of the installation process. 

 
Important note: Using the menu at the bottom, you can select all the Windows users who 
will be authorised to use Classroom manager. Select “Everyone” (all users) to specify that 
all users of this computer can use the program. Select “Only for me” if the program should 
only be used by yourself, the person logged on when the program was installed. 

 
 If you wish to define a specific path for the installation folder, select “Custom” mode for the 

type of installation. 
 

 
 
Note: The pane for selecting the type of installation only appears the first time that the Classroom 
Manager install program is run. If Classroom Manager has been installed previously and an 
update is being made, for example, the set-up wizard detects the existing installation and installs 
any new components at the location specified during that first installation.  
 
4. Click “Next”. The following window appears to notify you that the actual installation is ready 

to begin. Click “Back” if you wish to amend any of the settings you have made. Otherwise, 
click “Next” to proceed with the installation. Installation is then carried out. The process 
can last for several minutes. 
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5. Once the installation is finished, the following pane is shown. Click “Finish” to complete 

the installation.  
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3 .  M a n a g e r  
 
LabSoft Manager is used to configure and manage the LabSoft installation on a computer or in 
a local network. It allows you to create, modify or delete users, groups, courses or tests. It can 
assemble individual course programs for groups (classes). 
 
Note: Manager can be used to edit the LabSoft.config file for your LabSoft installation. Since 
this file is installed in the Program Files folder in a standard LabSoft installation, administrator 
rights are needed to modify the file. 

3 . 1  S t a r t  
 
Run Manager using the “Start” button in your Windows task bar. As long as you have not changed 
the path for the program icon during installation, it should appear under: 
 
Start  All Programs  Classroom Manager  Manager 
 
Note: Windows 7 will display a security prompt, which requires you to confirm that the program 
is to be started. If your user account has the requisite administrator rights, click “Yes”. If your 
account does not have such rights, you need to enter the user name and password for an account 
that does have them in order to run LabSoft Manager. 
 

 
 
First select the desired language for the program and confirm with “OK”.  
 
Note: You can disable the language prompt in future by setting the checkbox, “Do not show me this 
message in future”. The Editor program will then always start in the language now selected. If you 
should want the prompt to be shown at a later date, you need to hold down the “Shift” key when 
opening the program.  
 

Important note: The Manager program only starts with all sections if the supplied USB 
dongle is inserted into one of the computer’s USB ports. If the dongle is not present, the 
program will start without the sections “Reports” and “User Files” after the following error 
message is confirmed with “OK”: 
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The user interface for LabSoft Manager is divided into 7 sections, which can be selected via the 
icons on the left-hand edge of the window or by means of the “View” menu. When LabSoft 
Manager is started, the “Configuration” view is displayed initially.  
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3 . 2  C o n f i g u r a t i o n  v i e w  
 

 
 
The “Configuration” window allows you to change the basic LabSoft settings.  
 

• Configuration file displays the configuration file currently being used by LabSoft. The 
settings for LabSoft are stored in this file. A different config file can be selected by opening 
it via the “File Open” option in the menu or by means of the  icon on the tool bar. If a 
new configuration file has been selected, it can be registered for the existing LabSoft 
installation with the help of the menu option “File – Register file”.  

 
Important note: If no LabSoft installation was in place on the computer at the time LabSoft 
Classroom Manager was installed, or if it was not possible to read the configuration file at 
that point, the words “<not loaded>” will appear after the configuration file entry. In this 
case, you should open the configuration file as described above. 
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• Local user data sets the default folder in which the user data file is to be saved. The 
“Browse” button allows the folder to be changed (see “Users” view). The chosen folder 
can be on any drive accessible within the local network. 

 
• Use database is non-functional 

 
• Use LMS allows the course and user data to be managed by an external LMS (Learning 

Management System). The “Address” field in this case refers to the address of the log-in 
or start page for the LMS and you should enter that here. In this case courses and users 
need to be entered in the LMS. LabSoft is then used only for displaying the courses and 
providing the virtual instruments.  

 
• Log-in provides for various log-in options to be set for the use of LabSoft. The option 

“Enter name and password” makes it possible for LabSoft to demand that a name and 
optional password to be entered when it starts. If the “Use Windows login” option is set, 
LabSoft will run without asking for a user name. It then automatically utilises the user’s 
Windows user name. It is not necessary to enter a password in this case. 

 
• Disable login for non-registered users prevents LabSoft being run by any users other 

than those entered under “Users” in LabSoft Manager. Select this option to ensure LabSoft 
is only available to registered users. 

 
Important note: If options “Use Windows login” and “Disable login for non-
registered users” are both set then the Windows login name needs to be registered as 
a user in Manager. Otherwise it is not possible to run LabSoft. 
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3 . 3  G r o u p s  v i e w  
 

 
 
The “Groups” window allows for user groups to be edited. 
 

• Create new group New groups are added by pressing the “New” icon  on the tool bar. 
A new window will open, in which a name for the new group can be entered. Click “OK” to 
confirm creation of the new group. The new group will then be displayed in the 
“Identifier” (ID) field. Click the save icon  on the tool bar to save your changes. 

 
Note: The group “ALL” is pre-defined and is assigned by default to all the installed courses. If 
newly installed courses are to be made available to additional groups, they need to be assigned 
to those groups as well. 
 

• Delete existing group Highlight an existing group in the “ID” field using the mouse, then 
click the “Delete” icon  on the tool bar.  

 
Important note: Users assigned to a group which is to be deleted will also be deleted at 
the same time.  

 
• Assign courses/exams to a group Highlight the group to which the courses or exams 

are to be assigned from the ID field and select the actual exams and/or courses to be 
assigned from the “Courses/Exams” lists. Click the save icon  on the tool bar to save 
your changes. 
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• Assign users to a group Highlight the group to which the users are to be assigned from 
the ID field and select the actual users to be assigned from the “Users” list. Click the save 
icon  on the tool bar to save your changes. 

 
Note: Users can also be assigned to a group under “Users”. 
 

• Exam mode is disabled by default. In this case, all the groups registered for a course are 
displayed. Enable this option to conduct an exam/test in LabSoft. When exam mode is 
activated, the exams assigned to a group are displayed in LabSoft. In exam mode, 
navigation capability is deliberately restricted and exams can be taken once only. Click 
the save icon  on the tool bar to save your changes. 

 
• Disable selection of course category allows the simultaneous display of courses of 

various categories in the LabSoft navigation hierarchy. If this function is disabled (default), 
the navigation tree will display courses from one category only. The  icon on the LabSoft 
tool bar lets you toggle between categories. Click the save icon  on the tool bar to save 
your changes. 

 
• Enable teamwork makes it possible for multiple users to log in to a single LabSoft-session 

simultaneously. After the first user logs in, the menu option “Team – Administration” can 
be used so that others can also join the LabSoft session. The results obtained by all the 
members of the team are then saved. Team working can be enabled or disabled for 
individual groups. 
 

Note: Team working is supported by LabSoft versions as of version 7.40. The “Team” menu 
option is not present in older versions of LabSoft. 
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3 . 4  U s e r s  v i e w  
 

 
 
The “Users” window allows for users to be edited. 
 

• Create new user New users are registered in LabSoft by pressing the “New” icon  on 
the tool bar. A new window will open, in which a name for the new user can be entered. 
Click “OK” to confirm creation of the new user. The new user will then be included in the 
table of users. To finish with, assign the user to a specific group and establish a folder for 
storing user data. Optionally, you can enter the forename and surname of the user. If no 
folder is entered for user data, the default path set under “Configuration” will be used for 
storing all user data. Click the save icon  on the tool bar to save your changes. 

 
• Delete existing user Highlight the row in the table for the user to be deleted, then click 

the “Delete” button  on the tool bar. Click the save icon  on the tool bar to save your 
changes. 

 
Note: Click the “No.” field at the beginning of a row to mark the whole row. 
 

Important note: If users should forget their passwords, you can delete passwords using 
this window. Highlight a user by clicking the “No” field at the start of the row and select 
“Delete password” from the “Options” menu. The user’s password will be deleted. The 
next time they open LabSoft, it will request entry of a new password.  

 
• “Group membership” column Double clicking any cell opens a drop-down menu with all 

the existing groups. From the menu, select the group to which the user is to be assigned,. 
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• “Folder for user data” column Double clicking the cell causes a  button to appear so 
that you can choose a folder path for storage of user data. Click the button and select the 
appropriate folder. If no save folder is entered, the default folder will be used. 

 
Note: You can also copy the path directly into the cell. 



 

 

Instruction manual 
LabSoft Classroom Manager 5.0 

 

19
 

3 . 5  C o u r s e s  v i e w  
 

 
 
The “Courses” window allows for courses to be registered or deleted. 
 

• Create new course New courses are added by pressing the “New” icon  on the tool 
bar. A new window will open, in which a name for the new course can be entered. Click 
“OK” to confirm creation of the new course. The new course will then be included in the 
table of courses. Then enter a description, category and the toolset associated with the 
course, as well as a path to which it should be saved.  

 
Important note: The “Location” column indicates the location of the IMSmanifest file for 
the course (imsmanifest.xml). If such a file is not actually to be found at the location 
specified, no entry for the course will be displayed in LabSoft. 

 
Tip: Highlight a course with the mouse and then click “Insert copy…” in the “Edit” menu. A new 
window will appear, in which you have to enter the ID for the new course. A new line with the ID 
for the new course will be added to the list. Entries in other fields are simply copied. Only those 
entries which need to amended have to be modified. 
 
Note: New courses installed from CD are registered automatically. New courses that have been 
made using the Editor are also registered as long as the “Register course in LabSoft” option has 
been selected (see section 4.3: Creating a new course). This means that manual registration of 
a course is not usually necessary. 
 

• Delete existing course Highlight the row for the course to be deleted in the table, then 
click the “Delete” button  on the tool bar.  
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Note: Click the “No.” field at the beginning of a row to mark the whole row. 
 

• “ID” column This column determines the ID to be used for the course. This ID is used 
internally for identifying the course.  

 
Important note: A course ID cannot subsequently be altered once entered since there is 
no longer any guarantee that the course will function properly. 

 
• “Description” column This column lets you specify an internal name for the course. The 

description appears only in LabSoft Manager and may be used, for example, to identify 
the course within the “Groups” window. 

 
• “Category” column This column determines the category under which the course is listed 

in LabSoft. 
 

• “Toolset” column This column displays the set of virtual instruments that should be used 
with the course. A list of the available toolsets can be found in the online help for LabSoft 
Manager. 

 
• “Location” column This column determines the location where the course is stored. 

Double clicking the cell causes a  button to appear so that you can choose a folder path 
where the course is stored. Click the button and select the folder where the course is 
saved. 

 
Note: You can also copy the path directly into the cell. 
 

Important note: The “Location” column indicates the location of the IMSmanifest file for 
the course (imsmanifest.xml). If such a file is not actually to be found at the location 
specified, no entry for the course will be displayed in LabSoft. 
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3 . 6  E x a m s  v i e w  
 

 
 
The “Exams” window allows for courses to be registered or deleted. Exams are registered in much 
the same way as courses (see section 5.4: Courses). Exams are only displayed in LabSoft if they 
are registered for a specific group and the “Exam mode” flag has been activated for that group 
(see section 5.3, Groups).  
 

• Create new exam New exams are added by pressing the “New” icon  on the tool bar. 
A new window will open, in which a name for the new test can be entered. Click “OK” to 
confirm creation of the new test. The new exam will then be included in the table of 
exams.  

 
Important note: Exams can be created using TestCreator. Any new exams created using 
TestCreator are registered automatically. This means that manual registration of an exam 
is not usually necessary. 

 
• Delete existing exam Highlight the row for the test to be deleted in the table, then click 

the “Delete” button  on the tool bar.  
 
Note: Click the “No.” field at the beginning of a row to mark the whole row. 
 

• “ID” column This column determines the ID to be used for the test. This ID is used 
internally for identifying the test.  
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Important note: A test ID cannot subsequently be altered once entered since there is no 
longer any guarantee that the exam will function properly. 

 
• “Description” column This column lets you specify an internal name for the exam. The 

description appears only in LabSoft Manager and may be used, for example, to identify 
the exam within the “Groups” window. 

 
• “Category” column This column determines the category under which the exam is listed 

in LabSoft. 
 

• “Toolset” column: This column displays the set of virtual instruments that should be used 
with the exam. A list of the available toolsets can be found in the courses view of LabSoft 
Manager. When TestCreator is used to create an exam, an entry for it will be made 
automatically and manual entry is not required. 

 
• “Location” column This column determines the location where the exam is stored. 

Double clicking the cell causes a  button to appear so that you can choose a folder path 
where the course is stored. Click the button and select the folder where the exam is saved. 

 
Note: You can also copy the path directly into the cell. 
 

Important note: If the “IMSmanifest.xml” file is not actually to be found at the location 
specified, the exam will not be displayed in LabSoft. 
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3 . 7  R e p o r t s  v i e w  
 

 
 
The “Reports” window allows for the registered courses and users to be organised in tables, 
sorted and printed out. Sorting can be top to bottom or bottom to top and by any specific column 
you choose. To sort, simply click the title header of the respective column. The data to be 
displayed (courses or users) can be selected via buttons. 
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3 . 8  U s e r  f i l e s  v i e w  
 

 
 
The “User files” window allows for editing of sample solutions or the user files for a user. The 
following changes can be made: 
 

• “Open” This button opens the relevant user file. The file will then be displayed in the field 
on the left. The name of the file matches the login name of the user. Results for each 
course are saved in separate directories within the file. The name of the directory matches 
the course ID (see section 3.5: Courses).  

 
Important note: Any user files already opened in LabSoft (i.e. the user is currently working 
in LabSoft) cannot be opened. 

 
• “Delete” This button deletes the currently highlighted entry from the file. The entry is not 

actually physically deleted. To delete it utterly, use the “Clean” key afterwards. 
 
Note: Only one directory or entry can be highlighted at any one time.  
 

• “Rename” This button lets you rename a directory within the user file.  
 

• “Merge” This button allows another user file to be merged with the one currently open.  
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• “Clean” This button physically wipes any entries that have already been deleted using 
the “Delete” button.  

 
• “Export (XML)” This button allows the user file to be converted and exported as an XML 

file.  
 

• “Import” This button allows results data to be imported from an XML file.  
 

• “Close” This button finishes editing of the results and closes the file again.  
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4 .  E d i t o r  
 

Important note: This compact manual only deals with the key basic functionality of the 
Editor component. Detailed information on additional functions can be found in the online 
help for the Editor component. 

 
 

4 . 1  S t a r t  
 
Open the Editor using the “Start” button on the Windows task bar. As long as you have not 
changed the path for the program icon during installation, it should appear under:  
 
Start  All Programs  Classroom Manager Editor 
 

 
 
First select the desired language for the program and confirm with “OK”.  
 
Note: You can disable the language prompt in future by setting the checkbox, “Do not show me this 
prompt in future”. The Editor program will then always start in the language now selected. If you 
should want the prompt to be shown at a later date, you need to hold down the “Shift” when opening 
the program.  
 

Important note: The Editor program only starts if the supplied USB dongle is inserted into 
one of the computer’s USB ports. If the dongle is not present, the program will not start 
and the following error message will appear: 
 

 
 
 
The Editor program opens by default at a start page from which the following actions can be 
selected: 
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Edit course 
Clicking with the mouse on “Edit course” opens a wizard allowing modifications to be made on a 
specific course. The original files of the course are modified directly.  
 

Important note: Do not use this option if you might wish to use the original version of the 
course again. To restore a course to its original state after editing, the course would first 
need to be de-installed from the Windows control panel, then reinstalled from the original 
CD. 

 
Create course 
Clicking with the mouse on “Create course” opens a wizard allowing a new course to be created. 
There is also an option to copy an existing course. In this event, all the original files are copied 
over from the existing course, which itself remains unchanged. 
 
Recently opened projects 
This displays a list of the most recently modified courses. Clicking on the entry for a specific 
course reopens that course for further editing. 
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4 . 2  E d i t i n g  a n  e x i s t i n g  c o u r s e  
Clicking with the mouse on “Edit course” opens the wizard allowing modifications to be made on 
the specified course. 
 

 
 
A list window shows all the courses registered in LabSoft, from which the course to be edited 
can be selected. Select the required course, then click “Next”. 
 
Note: Alternatively, any other courses which have their structure defined in an IMSManifest file 
can also be loaded into Editor. To load another course in this way, activate the “Other course” 
option and click the “ ” button to browse for the course on the local computer or the network. 
Afterwards, click “Next”. 
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The following window displays the parameters for the course as determined by the Editor. It is 
usually unnecessary to modify these parameters. Click “Next”.  
 
Note: Click the “Help” button for information on the individual parameters. 
 
Click “Finish” in the subsequent pane to load the course to be edited into the Editor. 
 

 
 
The course now appears in the Editor much as it would in LabSoft itself. The navigation tree for 
the course is on the left and the content of the page selected in the tree is shown on the right. It 
is now possible to edit the course. A brief introduction to editing can be found starting at section 
4.4.  
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4 . 3  C r e a t i n g  a  n e w  c o u r s e  

 
Clicking with the mouse on “Create course” opens a wizard, allowing a new course to be created. 
The wizard provides the option of copying an existing course, creating a course based on a 
template or creating an entirely empty course structure.  
 

 
 
The window also requires entry of a name for the new course as well as a path to the folder where 
it is to be saved, either on the local computer or in a local network. The option “Sub-folder for files” 
allows a sub-folder of the course directory to be specified if the individual pages of the course 
(HTML files) are to be stored separately from the structure file. The “Prefix for filenames” option 
defines a prefix to be added automatically to the name of each new course file. This can be useful, 
to make it easier to find the specific files for the course later, for example.  
If the “Register course for LabSoft” option is selected, the new course will automatically be added 
to the LabSoft registry. In this event, further information needs to be entered in subsequent wizard 
panes. 
 
Note: If an existing course is copied for use as a template, the “Subfolder for page files” entry 
field must be left empty. If any sub-folder is already in existence, this will be used automatically. 
 
Note: Click the “Help” button for information on the individual parameters. 
 
Depending on the options selected under “Templates”, the wizard may progress in different 
ways: 
 

• “Create empty course” template used and “Register for LabSoft ” option not selected 
• “Copy template” template used and “Register for LabSoft ” option not selected 
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These scenarios require no additional steps and the new course is created immediately.  
 

• “Copy existing course” template used and “Register for LabSoft ” option not selected 
 
The following window is shown, allowing selection of the course to be copied. 
 

 
 
Note: If an existing course is copied for use as a template, the “Sub-folder for files” entry field 
must be left empty. If any sub-folder is already in existence, this will be used automatically. 
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Note: If the template option “Copy existing course” is selected, all the files belonging to the course 
will be copied. The actual course used as a template remains unchanged. This represents the 
easiest way to create a new course. 
The course is then created (press “Finish” as above). 
 

• “Create empty course” template used and “Register for LabSoft ” option is selected 
• “Copy template” template used and “Register for LabSoft ” option is selected 

 
In the first window of the assistant select the option „Register course for LabSoft“. Click “Next”.  
 
 

 
 
Note: Click the “Help” button in the wizard for information on the individual parameters. 
 
The subsequent pane appears, allowing you to set the parameters for registering the course in 
LabSoft. 
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The following parameters are required: 
 
Unique course ID:  Every course in LabSoft needs a unique identifying code. The wizard 

will automatically create an ID for a new course (see section 3.5, 
Courses, under “Manager”). This ID begins with a language code, 
(e.g. “ENU_”) followed by a random number sequence. The language 
ID should match the language in which the course is written. The full 
ID can, however, be changed manually. Further information can be 
obtained from the online help for the wizard. 

 
Course category:  This specifies a category under which the course will be displayed in 

LabSoft. A pull-down menu allows you to select any of the categories 
already in existence or you can specify a new category by typing a 
name in the relevant field. 

 
Toolset:  This specifies a set of virtual instruments to which the course should 

have access. A list of available toolsets can be found in the list of 
installed courses in the Courses view of LabSoft Manager.  

 
User group: Here you can select a group of users who are to have access to the 

new course. 
 
Click “Next”, then “Finish” on the next pane to start editing the course in Editor. The course will 
be registered in LabSoft at the same time.  
 
 

• “Copy existing course” template used and “Register for LabSoft option” is selected 
 
The following window is shown, allowing selection of the course to be copied. 
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The subsequent pane appears, allowing you to set the parameters for registering the course in 
LabSoft.  
 

 
 
The following parameters are required: 
 
Unique course ID: Every course in LabSoft needs a unique identifying code. The wizard 

automatically creates an ID for the new course. This ID begins with a 
language code, (e.g. “ENU_”) followed by a random number 
sequence. The language ID should match the language in which the 
course is written. The full ID can, however, be changed manually. 
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Further information can be obtained from the online help for the 
wizard. 

 
Course category:  This specifies a category under which the course will be registered in 

LabSoft. A pull-down menu allows you to select any of the categories 
already in existence or you can specify a new category by typing a 
name in the relevant field. 

 
Toolset:  This specifies a set of virtual instruments to which the course should 

have access. The toolset of the course being copied is adopted 
automatically but it is also possible to enter a toolset manually. A list 
of available toolsets can be found in the list of installed courses in the 
Courses view of LabSoft Manager. 

 
User group: Here you can select a group of users who are to have access to the 

new course. 
 
 
Click “Next”, then “Finish” on the next pane to start editing the course in Editor. The course will 
be registered in LabSoft at the same time.  
 

 
 
The course now appears in the Editor much as it would in LabSoft itself. The navigation tree for 
the course is on the left and the content of the page selected in the tree is shown on the right. It 
is now possible to edit both the navigation tree and the course. 
 

Important note: When installing in a network and using UNC paths, it may be that the 
pages of the newly created course do not appear in LabSoft. If this occurs, open LabSoft 
Manager and change the path entry under the heading “Courses” by manually adding 
“file:” to the beginning. 
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Example:   \\server_xy\Labsoft\BooksDEU\1A00\ 
     would be changed to file:\\server_xy\Labsoft\BooksDEU\1A00\ 
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4 . 4  E d i t i n g  a  c o u r s e  
 

4.4.1 Editing the navigation (course) structure 
 
The navigation tree for the course is shown on the left-hand side of the window as it is in LabSoft. 
Above the navigation tree there is a menu bar. This menu bar effectively allows you to move, 
delete or modify pages or to add new pages.  
 

 
 
Moving pages: Individual pages or whole chapters can be moved anywhere in the 

navigation structure by any of three methods: by clicking the buttons 
(blue arrows) on the menu bar, by drag and drop (holding down the 
left mouse button) or by clicking with the right mouse button to open 
the pull-down context menu. 

 
Renaming pages: Individual pages or chapters can be renamed in any of three ways: by 

clicking again with the left mouse button on a page that has already 
been selected, by clicking the right mouse button on a selected page 
to open a pull-down context menu or by clicking the  icon on the 
menu bar. The last two methods both open the Properties dialog 
window. In this window it is possible to modify the icon for the course, 
titles in the navigation tree and the corresponding HTML file for a page. 
The path where the HTML file is saved is also displayed. 

 

 
 
Deleting pages: Individual pages or whole chapters can be moved anywhere in the 

navigation structure by any of three methods: by clicking the  button 
on the menu bar, by clicking to select them and pressing the “Del” 
button on the keyboard or by clicking with the right mouse button to 
open the pull-down context menu. 

 
Important note: If a page you are seeking to delete has child pages beneath it in the 
hierarchy, the selected page and all its children will be deleted. 
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Creating new pages: New pages can be added by clicking the  icon or by using the pull-

down menu opened with a right mouse click. The new page will be 
added after the one currently selected. When a page is created, a 
dialog window opens in which you can enter the properties for the 
page. 

 

 
 
The following parameters can be set: 
 
Insert:  The new page can be inserted at the same level as the current page 

or as a child page of it. 
 
Icon image: An icon for the page can be selected from a pull-down menu. 
 
Title: The page title for the navigation tree can be typed into the “Title” entry 

field. If this page title is later amended, the new title will automatically 
be used as the title displayed on the course page itself. 

 
Filename: The filename of the HTML file can be specified in this entry box. 
 
Template: Content can be typed into the new page immediately. This can be 

done using a standard template, by copying the currently selected 
page or any other HTML page, as selected via this option. If the current 
page or another HTML page has been selected, the pages are copied 
along with any other files they reference. 

 
Important note: If a new course has been created using the “Copy existing course” option, 
it may be the case that new pages made from templates are not displayed correctly since 
the templates themselves are missing. In this case the missing templates can be added 
by selecting “Options – Copy Templates“ from the menu. 
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Import pages: It is possible to import one or more pages from another course. To 
import pages, select “Import” from the main “File” menu. This will open 
a wizard, which helps you to import data from the other course. Follow 
the wizard’s instructions to copy the page you want. 

 

 
 

Alternative structure: This  button allows you to establish various alternative structures 
for a course. It opens an edit menu allowing additional structures to be 
created or existing ones deleted. This makes it possible to create 
multiple versions of a course (e.g. one for beginners and one for more 
advanced students).  

 

4.4.2 Editing course pages 
 
To edit a course page, the relevant page must first be selected from the navigation tree. Next, 
click on the page itself. Only then will the menu options applicable to the editing of pages be 
enabled on the menu bar. The Editor provides for three ways to view the page, which can be 
selected via the tabs at the bottom of the window. 
 
Note: The main menu for the Editor changes depending on the selected view. 
 

 
 
Design:  Design view shows the page more or less as it will finally appear in LabSoft. 

Graphics are always displayed but embedded objects such as Flash animations 
are not always shown until they are activated by double clicking the element 
itself. In addition, border markings are also displayed for objects and graphics. 
The Design view is the most common view to use for editing a page.  
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HTML: This view allows you to edit the HTML source code for the page directly.  
 

Important note: You should not try to edit HTML code unless you have a good 
understanding of HTML. Mistaken entries or deletion of certain elements can cause the 
page to be displayed incorrectly or not at all. 

 
Preview: This view shows the page exactly as it will later appear in LabSoft. The page 

cannot be edited in preview mode. Menu options for editing the page are 
disabled. 

 
Design view 
 
The design view lets you edit the page much as you would in a word processing application. 
Commonplace functions (like text formatting, inserting a graphic, paragraph formatting or creating 
a list) are made available on the tool bar. Less common functions may be found via the menu bar.  
 
Note: A full description of all the menu options can be found in the online help for the Editor under 
Help/Help topics/Editor/Menus. 
 

 
 
Functions on the tool bar from left to right: 
 
Block format is for formatting the block around the current cursor position. The formats offered 
for selection are defined in a CSS stylesheet. 
 
Format is for formatting the actual element where the cursor is situated. A window will open, 
which allows for the formatting to be specified. Various parameters will be displayed depending 
on the element in question. Selection of an element can be modified manually via the edit window 
on the left.  
 
Note: Formatting of elements is achieved using HTML attributes specific to the element in 
question. The “Format” window allows these attributes to be set with specific values. A pull-down 
menu displays the relevant values depending on the element and its attributes. 
 
Character formats B, I, U cause the text to be formatted either bold, italic or underlined. 
 
The Bullet symbol creates an unordered list. 
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Numbering creates a numbered list. 
 
Indent/outdent symbols indent or outdent paragraphs or lists. 
 
Alignment symbols set the formatting for a paragraph (left, centred, right) 
 
An Insert picture button inserts an image at the cursor position. A dialog window opens to allow 
the file for the image to be specified along with various other properties. 
 
Insert link transforms the highlighted text or image into a hyperlink. 
 
Edit HTML opens a window allowing the HTML source for the section indicated by the cursor to 
be edited.   
 
Less common functions may be found via the menu bar. The individual menu options will not be 
described in detail here. A full description of all the menu options can be found in the online help 
for the Editor under Help/Help topics/General Menus. 
 
Insert menu  
 
Object 
 
This menu option features various types of media object which can be inserted into a page: 
 
Flash animation… This opens a dialog window for inserting a Flash animation into a page. Click 

the folder icon  to select a Flash file (.swf). There is also an option to 
change the size of the file as displayed on the page.  

 

 
 
PictView… This opens a dialog window for inserting an LN PictView object. PictView 

allows storage of graphics obtained from measurements made by the virtual 
instruments (e.g. oscilloscope traces, Bode plots, etc.) in LabSoft. Select the 
“Meta files” format and a WMF file to insert a placeholder. 
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TableView… This opens a dialog window for inserting an LN TableView object. TableView 

objects allow measurements to be stored in table form. The table can be 
switched to Chart mode to display a graph of the values. Click the folder icon 

 to select a layout file(*.tvly).  
 

 
 
Note: Layout files can be generated using the TableEdit program component of LabSoft 
Classroom Manager (see section 8 TableEdit program).  
 
Plug-in… This opens a dialog window for inserting an embedded object handled by a 

specific plug-in. You can use it to insert video files, animations, sound files 
or other objects, which can be played back as long as the relevant plug-in is 
installed on the user’s computer. Click the folder icon  to insert a file to be 
handled by a specific plug-in. 
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ActiveX element This opens a dialog window for inserting an ActiveX element. Select the 

desired element and then click OK.  
 

 
 
Note: More information about ActiveX elements can be found in the help for the Editor component 
under “General menus – Insert”. 
 
Formula… This opens a dialog window for creating a mathematical formula. Click “OK” 

to insert a finished formula into the page as a PNG (graphic) file. Double 
clicking the graphic in design mode opens the formula in the formula editor 
again.  
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Questioner This opens a dialog window for inserting a question generated using the 

Questioner component (see section 5: Questioner). The window shows all 
the questions in the database relating to the course. Select the question or 
group of questions to be inserted and click OK.  

 

 
 

 
Important note: If the Questioner is disabled (greyed out), check whether there actually 
is a question database assigned to this course, i.e. if there is a file with the name qadb in 
the course folder. If there is such a file, select “Properties” from the main “File” menu and 
enter its name in the “Database” field of the “Project properties” dialog window.  

 
 

Note: If the option “Generate questions dynamically” is selected, the questions are not statically 
embedded in the page but are generated from the database anew whenever the page is entered. 
If the option is on, a placeholder will be shown in the design view instead of actual questions. 
 
 
Options menu  
 
Customise files This opens a dialog window which enables global changes to be made to a 

course or page. Alternative script or CSS (Cascaded Style Sheet) files can 
be entered and various settings can also be activated: 

• In LabSoft courses, the title headers are contained within the HTML 
code for a page. The option “Convert title tables” can be used to 
change the appearance of the page title with the help of a CSS file. 

• “Synchronise structure and page titles” matches the titles in the 
navigation tree to those of the pages. 

• “Enable visual styles” allows you to use the Windows library such 
that buttons, for example can look like those included in the 
Windows library installed on the computer. 
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• “Insert script tags into <body>” allows additional parameter options 
to be added inside the <body> tag. 

Note: All changes can be made to individual pages or to the course as a whole. 
 
SCORM compatibility… This enables global modifications to be made to a course in order to 

make it usable as a SCORM-compatible training programme in a 
Learning Management System. 

 
Print compatible version… This opens a dialog window which enables a print-compatible 

version of the course to be generated in the form of a single HTML 
file for the entire course. 

 
Create install package This opens a dialog window which helps you create setup files for 

installing courses you have created. The alternatives include 
creating a setup file for installing LabSoft courses into an existing 
LabSoft installation or generating a zip file for uploading the course 
to a Learning Management System. 

 
 
Copy template This copies the standard template files (script, css) used by the 

Editor into the corresponding course folder. 
 
Customise This opens a dialog window in which general settings for the Editor 

can be changed. 
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5 .  Q u e s t i o n e r  
 
The Questioner program makes it possible to generate questions for which the answers can be 
checked automatically. Users of the course (students) can thus get immediate feedback as to 
whether their answer or measurement data is correct. The questions and the corresponding 
evaluation logic are stored in a separate file.  
 

5 . 1  S t a r t  
 
From the Editor it is possible to run Questioner by clicking the  icon at the top right of the tool 
bar. Questioner then automatically opens the question and answer database (qadb file) 
associated with the course.  
 

 
 

Important note: If no question database is loaded into Questioner, check whether there 
actually is a question database assigned to this course, i.e. if there is a file with the name 
qadb in the course folder. If there is such a file, select “Properties” from the main “File” 
menu and enter its name in the “Database” field of the “Project properties” dialog window. 
Save changes in the Editor. If you open Questioner again, the selected database will be 
opened. 

 
Questioner can also be run as a separate program. Use the “Start” button in the windows task 
bar. For a standard installation Questioner can be found under: 
 
Start  All Programs  Classroom Manager Questioner 
 

 
 
Select the desired language for the program from the list field and confirm with “OK”. 
 
Note: You can disable the language prompt in future by setting the checkbox, “Do not show this 
message in the future”. The Questioner program will then always start in the language now selected. 
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If you should want the prompt to be shown at a later date, you need to hold down the “Shift” key 
when opening the program. 
 

Important note: The Questioner program only starts if the supplied USB dongle is 
inserted into one of the computer’s USB ports. If the dongle is not present, the program 
will not start and the following error message will appear: 
 

 
 
If the USB dongle is plugged in, the program will run. 
 

 
 
After starting the program from the “Start” menu, the first thing to do is to open a question and 
answer database. Either choose the “Open” option from the “File” menu or click the  icon on 
the tool bar. A dialog window will open which allows you to select the relevant database (qadb 
file).  
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The file will then be opened with questions and question groups being displayed on screen. The 
main preview window will initially show the questions contained in the question group at the top 
of the list. 
 

 
 

5 . 2  S e t t i n g  u p  n e w  q u e s t i o n s  a n d  q u e s t i o n  g r o u p s  
 
Questions can be assigned to groups in the question and answer file. Questions and groups are 
shown in a tree hierarchy at the left of the screen in the Questions view, which is similar to the 
navigation structure in the Editor.  
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Important note: Individual questions or entire groups of them can be taken from the 
question and answer file and used in the course. Structuring of the questions into various 
question groups is thus very important for importing the questions into the course. 

 
With the help of the menu bar above the tree, new questions can be generated and existing 
ones edited, deleted or moved. 
 

 
 

5.2.1 Creating a new question group 

 
 
A new question group is established by clicking with the mouse on the icon shown above. This 
opens a dialog window in which you can specify a name for the question group. The new group 
will be listed underneath the question or group currently selected in the main window. Arrow 
buttons  allow the position of the question group to be moved to another place in the 
tree subsequently. 
 

5.2.2 Creating new questions 

 
 
A new question is established by clicking with the mouse on the icon shown above. This opens 
the dialog window shown below. Enter a title for the question into the “Title” field. Activate the 
“Create from template” option to obtain some example text which you can replace to create your 
question. The “Measurement exercise with hardware” option provides additional fields for meta 
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data (supplementary information for the description of the question, see Meta data section). 
Activate this option when a measuring exercise using actual hardware is intended to be used later 
on in a test created using TestCreator (see section 6: TestCreator). 
 

 
 
Note: The title of the question is displayed along with the actual results achieved when student 
progress is being evaluated by Classroom Manager’s Reporter program. You should therefore 
use short but preferably meaningful titles for your questions. This will help you later when 
evaluating student progress. 
 
The following types of question can be created: 
 
Single choice This is a multiple choice type question in which only one of the possible 

answers is correct. 
 
Multiple choice This is a multiple choice type question in which several possible answers can 

be selected from the responses supplied. 
 
Gap text This type of question can be used to evaluate text or numeric entries. Fixed 

answers or numeric ranges can be specified as right or wrong. 
 
Selection This question type involves choosing the right answer from a pull-down 

menu. 
 
Free text This type of question simply provides a text field, in which any answer can 

be written.  
 

Important note: It is not possible to check if the contents of any answer to this last 
question type are right are wrong.  

 
Image selection The answer to this type of question is given by selecting a graphic image. 

For instance, a correct characteristic can be selected from an image 
including several possible characteristic shapes. 

 
Matrix This type of question involves a matrix where selections can be matched to 

any of up to six possible answers. 
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Deleting questions or groups 

 
 
To delete a question or group of questions, highlight the relevant entry in the structure tree, then 
click the  button.  
 
Copying questions or groups into a course 

 
 
To copy a question or group into a course, highlight the relevant entry in the structure tree, then 
click the  button. button. Afterwards, switch to the Editor, move the cursor to the desired position 
on the course page (Design view) and press the “Insert” button   
 
Moving questions or groups 

 
 
To move a question or group within the tree hierarchy, highlight the relevant entry in the tree, then 
use the blue arrow buttons to move it to the correct position. This can be done as often as you 
like and does not affect how the question functions.  
 
Collapsing or displaying entries in the tree 

 
 
The button above can be used to collapse all the tree entries (groups) or to open the branches 
for display. The button on the left opens up all groups so that all the questions are displayed and 
the one on the right collapses them all.  
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Meta data 
 
The idea of meta data is to provide more detailed information about a question and to establish 
certain other parameters. The TestCreator component of Classroom Manager can automatically 
create electronically evaluated tests or exams from a question and answer database (qadb file).  
 

Important note: To utilise the full functionality of the TestCreator program, it is necessary 
to fill out all the meta data entries in full. The Meta data field includes all the options shown 
in the image below for each question.  

 
 

 
 
The left-hand side of the “Meta data” always shows the meta data applying to the question or 
question group currently activated (selected) in the tree. Values for the data can be entered in the 
column on the right. If a question group is selected in the tree, the Meta data field will only display 
a more detailed description for the group. 
 
Standard meta data for all types of question 
 
Description This allows for a fuller description of the question to be entered. 
 
Topic This allows the general topic area to which the question belongs to be 

assigned from a drop-down menu. Click on the “Topic area” row and then 
click the  button to select areas. TestCreator uses this parameter in its 
filter function (see section 6: TestCreator). 
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Degree of difficulty This allows the degree of difficulty for a question to be assigned from a 

drop-down menu. Click the column on the right next to “Difficulty” and then 
the  button to specify the degree of difficulty. TestCreator uses this 
parameter in its filter function (see section 6: TestCreator). 

 

 
 
Resources All the resources used by the question (e.g. images used in image 

matching questions or PDF data sheets) need to be entered into this field. 
This is absolutely essential, since TestCreator needs this information 
when creating tests. Click the “Resource” row and then the  button. 

 

 
 

A dialog window will now open. It includes a table, into which you can 
enter the required resources. Double click a row and then the folder 
symbol  at the end of the row in order to browse for the resource file. 
Click “OK” when you are finished. The number of resources needed is 
included and displayed in the meta data. 
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Max. score Here you should enter the maximum points to be awarded for answering 

the question correctly. Both the maximum points and the points actually 
gained are displayed for the courses or tests themselves by the Reporter 
program.  

 
Required time in secs. The time in seconds expected for the question to be answered 

should be entered here. TestCreator uses this information to determine 
the time required for a full exam or can automatically calculate the time 
for a random test or exam from it. The value is not actually relevant to the 
use of the question in courses themselves. 

 
Additional meta data for measuring exercises using hardware 
 
The meta data entered here can be relevant when measuring exercises are included as part of a 
test. It is not necessary to provide an entry for exercises within a course as the course itself 
uniquely establishes the data. 
 
Training system This allows the training system (e.g. UniTrain-I or InsTrain) for which the 

measuring exercise has been created to be specified. TestCreator uses 
this parameter as a filter option. 

 

 
 
Toolset Here you should enter the code for the toolset needed to answer the 

question. The toolset represents the set of virtual instruments which need 
to be provided by LabSoft for this exercise to be carried out in the event 
of a test. A list of available toolsets can be found in the list of installed 
courses in the Courses view of LabSoft Manager. For the standard toolset 
containing a basic set of instruments the code to be entered is “10”. 
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Equipment All the equipment (e.g. UniTrain-I Interface, experiment cards, Instrain, 
Cartrain, etc.) that needs to be used in a measuring exercise has to be 
entered here. This is absolutely essential, since TestCreator needs this 
information when creating exams. The required equipment is listed for the 
persons taking the exam on the opening page of the test itself, so that 
they can check that everything has been made available. Click the 
“Equipment” row and then the  button. 

 

 
 

A dialog window called Material will now open. It includes a table, into 
which you can enter the required equipment. Enter an ID (e.g. the order 
number), a description and the number of items of such equipment 
needed for the exercise. Click “OK” when you are finished. The number 
of items needed is stored and displayed in the meta data. 

 

 
 
Tip: Equipment lists generated in this way can be saved from the dialog window so that they can 
be used for other questions. To do this click the floppy disc icon  and enter a name for the list 
of equipment. Such a list can then be selected from the list box above the table. 
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5 . 3  E d i t i n g  a  q u e s t i o n  
 
To edit a question, first highlight the relevant entry in the structure tree on the left. The question 
can then be edited in the window on the right. Four different views are available, which can be 
selected via the tabs at the bottom of the window. 
 

 
 
Preview:  The preview shows the question exactly as it would later appear in a course. In 

this view, clicking the “Check answer(s)” button will also show whether the 
evaluation logic is working. If the check does not work as expected, the function 
can be modified again in the “Question” view. 

 
Question: This view allows for the question itself and the possible answers to be entered. 

Correct answers can be specified along with other parameters needed to 
evaluate the question. Depending on the type of question, a variety of entry 
fields or tables will be provided. 

 
Logic: In this view, precise logic for checking an answer can be modified by hand or 

created anew. The logic specifies the feedback that users get when they have 
entered an answer (whether the answer is correct, wrong, partially right, etc.) 
and how the answer should be evaluated as part of the student’s assessment. 
By default, the logic is generated automatically by the questions module and it 
is not necessary to modify it. 

 
Important note: You should only modify logic if you are familiar with logical notation. If 
you make a mistake, the question will no longer work properly. 
 

Note: The Logic view also allows for special feedback text to be defined specifically for the answer 
in question.  
 
Note: Further information on configuring the logic can be found in the help file for the Questioner 
program 
 
Feedback: This view displays all the globally defined feedback text entries (system 

responses to a student’s answer), presently known to the question and answer 
database. Additional feedback entries can also be added here.  

 
Note: Names for globally defined feedback entries must begin with a “#” if specified in the 
question. 
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5 . 4  E x a m p l e s  
 

5.4.1 Creating and inserting a missing text (gap text) question into a course page 
 
The following example demonstrates step by step how a missing words question is created and 
inserted into a course page.  
Click the symbol for creating a new question in Questioner.  
 

 
 
In the window that opens, select “New question” and specify the question type “Gap text”, then 
enter a name for the question. Since this question includes making a measurement, turn on the 
option “Measuring exercise using hardware”. Afterwards, click “OK”. 
 

 
 
The new question is then added to the structure tree and opened for editing in the main window.  
 

 
 
Now enter the specific contents of the question into the relevant fields of the main window, 
including the text for the question itself, text for any helpful tips and the answer that should be 
entered into the answer box.  



 

 

Instruction manual 
LabSoft Classroom Manager 5.0 

 

 

58 
 

“Question” field: Enter the text for the actual question here. 
 

 
 
Note: In order to add formatting or unusual characters to some text, mark the relevant section 
and click the right mouse button. You can select the desired formatting or character from the 
menu that appears. 
 

 
 
Optional “Hint” field: Any tips or hints can optionally be entered here. 
 

 
 
“Text” field: This is the text prompt for the solution. There is also a placeholder intended for a 
measurement value.  
 

 
 
A placeholder is generated by clicking the “New” icon above the entry box. 
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A window will now open, in which you should enter the correct answer that should appear in the 
placeholder. Placeholders can be defined for text, for numbers or for numeric ranges. In this 
example, let the correct answer be a number in the range from 4 to 6. Click “OK” to define an 
answer for the placeholder. 
 
Note: To insert additional placeholders, click the “New” button again. 
 

 
 
The logic for checking the answer in the placeholder at a later date will be created automatically 
and is displayed in the table further down the page.  
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Note: If you subsequently want to change one or more entries again at a later date, highlight the 
corresponding row of the table and click the “Edit” button shown above the table. The “Gap text” 
dialog window will then open and you can change the relevant entries. 
 

 
 
Now switch to “Preview”. Here you can test the question logic. Enter various numbers in the entry 
box for the question and press “Check answer” afterwards.  
 

 
 
You can save the new question by clicking the Save icon on the tool bar or by selecting “Save” 
from the “File” menu. Next, the question needs to be copied into the course. While in preview 
mode, you can use the “Copy” icon  on the menu bar above the structure tree.  
 

 
 
After this, you should switch from the Questioner program (back) to the Editor, position the text 
cursor in the design view at the desired point on the page and insert the question using the  
button. 
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The question will now appear on the course page at the selected position. 
 

 
 
Save your changes by selecting “Save” from the file menu or by clicking the “Save” button  on 
the tool bar.  
 
A detailed description of the functions and question types for the questions module can be found 
in the online help for the Questioner program in the menu under Help/Help topics. 
 

5.4.2 Creating a multiple choice question 
 
The following example indicates step by step how to make a multiple choice question  
 
Note: Creating single-choice questions works in an analogous way. 
 
Click on the new question icon in Questioner. 
 

 
 
In the window “New question” select and specify the question type “Multiple choice”, then enter a 
name for the question. Click “OK” when you have finished. 
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The new question is now added to the tree view and displayed in the main window.  
 

 
 
You can now enter the various parts of the new question into the individual fields of the main 
window: the actual text of the question, an optional hint and the answer options. 
“Question” field: Enter the text for the actual question here. 
 

 
 
 
“Optional hint” field: here you can enter text for an optional hint or other useful instructions. 
 

 
 
“Answer options” field: here you can enter the various answer options. Mark all the answers that 
are correct in the “Correct” column.  
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The entries can be edited by means of the following icons: 
 

 Inserts a new, empty row above the active row of the table with the answer options. 

 Deletes the active row of the answer options table. 

 Moves the active row of the answer options table up by one line. 

 Moves the active row of the answer options table down by one line. 

 Opens a dialog window for inserting an image into the active row. 
 
 

5.4.3 Creating an option matching (selection) question 
 
The following example indicates step by step how to create an option matching (selection) 
question 
 
Click on the new question icon in Questioner. 
 

 
 
In the window “New question” select and specify the question type “Selection”, then enter a name 
for the question. Click “OK” when you have finished. 
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The new question is now added to the tree view and displayed in the main window.  
 

 
 
You can now enter the various parts of the new question into the individual fields of the main 
window: the actual test of the question, an optional hint and the answer options. 
 
“Question” field: this is where you enter the actual question. 
 

 
 
 
“Optional hint” field: here you can enter text for an optional hint or other useful instructions. If the 
question does not need this, simply leave the field empty. 
 

 
 
“Answer options” field: Enter the options to be matched in the “Labelling” column. The “List 
entries” field is for the various answer options and the “Selection” column contains the line 
numbers of the “List entries” which actually match them. In the example below the correct answer 
option that matches the label for line 1 (Germany) is option 4 (Berlin). 
 

 
 
The screenshot below shows how this question would look in a course. 
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5.4.4 Creating an image matching (image selection) question 
 
The following example indicates step by step how to create an image matching (image selection) 
question. An image matching question involves a set image with various “clickable” regions which 
need to be matched with a set of answer options. It could, for instance, feature a set of different 
characteristics, whereby the correct one needs to be selected. Clicking a specific area of the 
image displays various “solution images” in place of the original. 
 
Click on the new question icon in Questioner. 
 

 
 
In the window that opens, select “New question” and specify the question type “Image selection”, 
then enter a name for the question. Click “OK” when you have finished. 
 

 
 
The new question is now added to the tree view and displayed in the main window.  
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You can now enter the various parts of the new question into the individual fields of the main 
window: the actual test of the question, an optional hint plus the various images and the 
coordinates for the clickable areas.  
 
“Question” field: this is where you enter the actual question. 
 

 
 
 
“Optional hint” field: here you can enter text for an optional hint or other useful instructions.  
 

 
 
“Images” field: This specifies the various images needed for the question. The initial image is 
specified in the top row of the table (marked red). To insert a new image, click the  button. A 
dialog window opens from which you can select the initial image to be used. 
 

 
 
Tip: Switch to “Preview” to see what the question will actually look like 
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Next the appropriate images for the various match options need to be entered. Position the cursor 
in the next empty row and click the  icon again. Insert the image as above. Now go to the “Form” 
and “Coordinates” columns to enter the shape of the clickable region and the coordinates with 
respect to the initial image of the region that needs to be clicked for this image to be displayed. 
The available shapes you can enter in the “Form” column are circles (circ), rectangles (rect) or 
polygons (poly). 
 

 
 
The coordinates that need to be entered to establish the position of the region for the image are 
dependent on the chosen shape. To define a circle requires the coordinates of the centre point 
plus a radius. The centre is defined by x-y coordinates (in pixels) from the top left of the image, 
and the radius is entered in pixels as well. 
In this example a clickable region in the form of a circle is to be positioned over each of the letters 
“A” and “B” on the initial image.  
Tip: In order to find out where the coordinates for an image lie, it can be opened in a simple 
drawing program, such as Paintbrush.  
 
Define all the required picture options in the same way.  
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The coordinates for images 1 and 2 define two circles over each of the letters “A” and “B” on the 
initial image. Clicking with the mouse in either of these regions causes the corresponding image 
to be displayed. Clicking a second time somewhere else on the image causes the original image 
to reappear.  
 

Click “A” (image 1):  Click “B” (image 2):  
 
Once all the images have been defined (initial image and all image options), select the option 
“Generate logic automatically” in the options field. 
 

 
 
The following image shows a preview of the question after “A” is clicked and the feedback for the 
answer. 
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5 . 5  C h a n g i n g  a s s e s s m e n t  c r i t e r i a  f o r  a  q u e s t i o n  d a t a b a s e  
 
 
For the purpose of calculating test results when questions are used as part of a test or exam, 
question database entries include an assessment key. The keys can be individually modified by 
users. To do this, select “Scoring” from the “Options” menu. The following window will open. 
Pressing the Standard button displays a list with the pre-set standard values filled in. 
 

 
 
The criteria for assessment of a test or exam can be modified here. They are used by the 
Reporter program to display the overall results for the test. 
 
In the "Condition" column of the dialog box, you can enter the logic to be used and in the “Result” 
column you enter the desired assessment results. Conditions are assessed in order from top to 
bottom. Assessment stops when the first matching condition is reached and the corresponding 
result is then assigned. 
 
You can use the standard values as a template for your own assessment criteria. The following 
options can be used for the assessment results: 
 
 

QUESTIONS Total number of questions

MAX_SCORE Maximum number of points which can be achieved

CORRECT Number of questions answered correctly 

INCOMPLETE Number of questions answered partially correctly 

FAILED Number of questions answered incorrectly 

UNANSWERED Number of questions not answered

SCORE Points (score) achieved

SCORE% The score obtained expressed as a percentage. 
This is SCORE / MAX_SCORE * 100 
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MAX_ASCORE Maximum score achievable from all questions 
answered 

ASCORE% Score obtained from those questions answered 
expressed as a percentage. This is equal to SCORE 
/ MAX_ASCORE * 100 

GUESS% "Guess factor". This is the percentage of questions 
answered which required more than one guess 

OTHER This is another condition which is applied in all 
cases 

 
 
For purposes of comparison, the following operatives can be used. 
 

< Less than

<= Less than or equal to

= Equal to

> Greater than

>= Greater than or equal to

 
 
In order to check multiple conditions, the following Boolean operators can be used: 
 

AND Carries out an “and” operation. The “&” character 
can also be used as an abbreviation for this. 

OR Carries out an “or” operation. The “|” character can 
also be used as an abbreviation for this. 

NOT This executes a Boolean negation of the following 
value or expression. The “~” character can also be 
used as an abbreviation for this. 
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6 .  T e s t C r e a t o r  
 
For carrying out tests and exams LabSoft provides a so-called exam mode (see section 3.3: 
Groups view). Exam mode only handles exams that are registered in the “Exams” view. 
 
Only one exam is displayed at a time. If multiple exams are registered for a certain group, they 
are opened by each user one after the other in sequence, i.e. every time LabSoft is started anew, 
a new exam will open until the user has completed all the exams. 
 
It is very easy to create such exams with the help of TestCreator. The starting points for creating 
exams are the question and answer databases (qadb files) created by means of the Questioner 
program. TestCreator can open multiple databases at a time, so that exams can be made up 
using questions from all those databases. Questions can be put together in an exam manually or 
automatically. A finished exam is automatically registered for the existing LabSoft installation and 
can immediately be registered for one or more groups.  
 

6 . 1  S t a r t  
 
 
Run TestCreator using the “Start” button in your Windows task bar. Unless you moved the 
program icon during the installation process, you can find it under:  
 
Start  All Programs  Classroom Manager TestCreator 
 

 
 
Select the desired language for the program from the list field and confirm with “OK”. 
 
Note: You can disable the language prompt in future by setting the checkbox, “Do not show this 
message in the future”. The TestCreator program will then always start in the language now 
selected. If you should want the prompt to be shown at a later date, you need to hold down the 
“Shift” key when opening the program. 
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Important note: The TestCreator program only starts if the supplied USB dongle is 
inserted into one of the computer’s USB ports. If the dongle is not present, the program 
will not start and the following error message will appear: 
 

 
 
After the program starts, there will initially be no question and answer database (qadb file) loaded. 
TestCreator has three display panels. On the left is the question pool window, which lists 
questions and question groups in a similar way to the Questioner component. The top right panel 
displays all the questions selected for an exam. The Preview window underneath displays the 
question currently selected. 
 

 
 

6 . 2  A d d i n g  a n d  r e m o v i n g  c o l l e c t i o n s  o f  q u e s t i o n s  
 
In order to load a question pool, also referred to as questioner database (qadb file), click the “Add 
question pool” icon  in the “question pool” window. In the dialog window that opens, select a 
question pool (qadb file), from which you want to select questions for an exam and then click 
“Open”.  
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Note: You can load multiple assignment collections into TestCreator in order to choose from a 
larger array of questions. 
 
Note: If you have loaded multiple assignment collections, you can use the “Save” option of the 
“File” menu to save the current status as a so-called “project”. This means the same set of 
questions can be loaded again and again later on. 
 
 

 
 
Click the “+” icon for the database or use the “Display all” icon on the tool bar to see all the 
entries in the assignment collection. 
 

 
 
Questions and question groups will then be displayed. 
 
Note: If you click on a question with the mouse, the question and all its meta data will be 
displayed in the preview window (see section 5.2.2: Creating questions).  
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Note: Questions cannot be edited in TestCreator itself. However, questions selected for a test 
can be opened in Questioner via the “Options” menu and modified there.  
 

 
 
The tool bar for the assignment collection window is exclusively for editing assignment 
collections. It provides the following options. 
 

 
 
Add assignment collection 

 
 
Clicking with the mouse on the above icon opens a dialog window for adding an assignment 
collection (qadb file). The assignment collection is added to the assignment collections already 
open. 
 
Remove assignment collection  

 
 
This icon removes an assignment collection from the set of assignment collections currently open. 
Clicking the button opens a dialog window which requires the removal to be confirmed. 
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Note: This button is only enabled if the top entry of an assignment collection is selected (before 
the mouse is clicked). 
 
Displaying and collapsing branches of the tree 
 

 
 
The button above can be used to collapse all the tree entries (groups) or to open the branches 
for display. The button on the left opens up all groups so that all the questions are displayed and 
the one on the right collapses them all.  
 
Define/remove filters 
 

 
 
The above button gives access to various filter functions which can be applied to assignment 
collections as well removing existing filters. Clicking the button opens a dialog window with the 
options “Define filter…” and “Remove filter”.  
 
“Define filter…” opens another dialog window in which you can configure settings for various 
filter criteria.  
 

 
 

Click the  button next to the filter criterion in question to display the various options available. 
When a criterion is opened for the first time, all the options will be set. You can activate or 
deactivate the options you want by setting or removing the ticks. The answers that have been 
filtered out will no longer be displayed in the tree. 
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Tip: You can use the "Select" and "Deselect" buttons to quickly configure multiple entries 
simultaneously. The commands only affect the entries currently being displayed, while others 
remain unchanged. 
“Remove filters” eliminates all the filters that have been set, so that all the questions in the 
assignment collection are displayed afterwards. 
 

Important note: The more carefully the meta data for the questions has been configured, 
the better the filter function will work. If a question has little or no meta data, it may not be 
properly handled by the filter function. Missing meta data can be updated using the 
LabSoft Questioner program (see section 5.2.2: Creating new questions)  

 
 

6 . 3  M a n u a l  s e l e c t i o n  o f  q u e s t i o n s  f o r  a n  e x a m  
 
To select questions for an exam manually, click the left mouse button on the desired question in 
the Question pool panel, keep the button held down and drag it into the main panel at the top right 
of the TestCreator window, then release the button (drag and drop). An entry will be displayed 
which includes the title of the question, the points to be awarded for it, the time it should take to 
answer, the degree of difficulty and the file path to the database (qadb file) in which the question 
is contained. In addition a preview of the whole question and all meta data is shown in the preview 
panel. The coloured bar at the right-hand side of the entry indicates the degree of difficulty for the 
question. 
 

 
Very easy    Medium Very difficult 

 

 
 
Drag all the questions you wish to include in the exam into the main window one after another. 
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Tip: You can make use of the filter function before selecting the questions if you wish to narrow 
down the choice of questions in advance. 
 
Having selected a question, you can remove it from the list subsequently by highlighting the 
question and selecting “Remove” from the “Edit” menu. Alternatively, you can use the  button 
on the tool bar or the “Delete” button on the keyboard. 
 

6 . 4  A u t o m a t i c  ( r a n d o m )  s e l e c t i o n  o f  q u e s t i o n s  f o r  a  t e s t  
 
In order to let the program choose test questions automatically, you can select “Create random 
test” from the “Options” menu or click the  icon on the tool bar for the main program. This opens 
a dialog window which allows you to set conditions for the generation of the test. Basically there 
are two key criteria which you can select for the automatic generator, either a duration within 
which the exam should be completed or the number of questions it should contain. 
 
Exam Duration 
If this option is selected, you can pre-select the time for the exam by specifying it in the format 
HH:MM:SS. TestCreator will then only add questions to the exam / test until adding any more 
would exceed the specified duration.  
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The selected questions will then be displayed in the main window of the TestCreator program.  
 

 
 
Number of questions  
With this option set, the specified number of questions are selected from the assignment collection 
at random.  
 

 
 
Note: In the event that some questions do not have meta data specifying the time they need for 
completion, a default time can be assigned by entering a time in seconds into the field “Time in 
seconds for questions with no specified duration”. 
 
Note: Set the option “Add questions to current test” if you want to add random questions to a set 
that you have already selected. This makes it easy to compile multiple tests with some questions 
in common and others that are different. 
 
The selected questions will then be displayed in the main window of the TestCreator program.  
 
Selected questions can be removed from the list subsequently by highlighting the question and 
selecting “Remove” from the “Edit” menu. Alternatively, you can use the  button on the tool 
bar or the “Delete” button on the keyboard. 
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Tip: You can make use of the filter function before the questions are selected if you wish to 
narrow down the choice of questions in advance. 
 

6 . 5  E x p o r t i n g  e x a m s  
 
Once the questions for an exam have been selected, the exam itself can then be generated. This 
works in similar fashion to the creation of a course. Select “Export test…” from the “Options” 
menu or click the  button on the tool bar. A dialog window will open, in which you can supply 
the necessary entries for the test / exam to be generated. 
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Label Enter a name for the new exam. This name will subsequently be displayed 
by the LabSoft Manager component in the “Description” field of its “Exams” 
view, as well as on the first page of the exam when it is opened.  
Tip: Select a meaningful and unique name so that you can easily recognise 
the exam from the list displayed in Manager.  

 

Destination folder: Click the folder  icon at the end of the entry field to specify a folder on the 
local computer or on a network where all the files needed for the test are to 
be saved.  

 
Important note: A exam consists of multiple files and folders. Therefore, every time a new 
exam is created, it should be assigned a unique folder of its own in order to make sure 
that previously created exams are not overwritten. If any data in an existing exam should 
be overwritten, that exam can no longer be run.  
Tip: Set up a logical repository in the “BooksENU” folder (where installed courses are 
saved) by creating a new sub-folder (e.g. called “Exams”) and make a separate folder 
under that for each newly created exam. You can find the full path where “BooksENU” is 
located by reading it from the “Location” column in the “Courses” view of the Manager 
program. 

 
Duration: This field contains the overall time needed to complete the exam summed 

from the individual durations specified for the questions within it. You can 
change the duration manually if you wish by specifying a time of your own in 
the format “HH:MM:SS”.  
Note: When a exam is taken, as soon as the specified duration has been 
exceeded, LabSoft automatically closes the exam. 

 
There are various other options in the dialog window that can also be selected.  
 
Scramble questions on opening: With this option set, every time the exam is opened the 

questions will be rearranged in random order. This makes it more difficult for 
students to cheat by reading a neighbour’s screen. 

 
Show results on final page: Setting this option means that those taking the exam will be able to 

see their results for each of the questions on the final page of the exam. 
 
Preview in Labsoft: If this option is set, once the exam has been generated (as soon as you click 

the “OK” button) LabSoft automatically launches in preview mode so that you 
can see the new exam, enabling you to quickly check through it 

 Note: For LabSoft to start up in preview mode like this, it first needs to be 
closed. Preview mode will not start if LabSoft is already running. 
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Register for user groups: If you set this option, you can immediately register the exam for one 
or more user groups. When the option is set, the desired user groups can be 
selected from the list box underneath.  

 

 
 
Unique ID: Every exam installed in LabSoft has a unique ID just as every course does 

(see section 4.3: Creating a new course). As soon as the dialog window is 
opened, an ID is automatically generated for the new exam. If you 
nevertheless wish to change this ID, you can enter a new unique code in this 
entry box. 

 
When you have finished making all the entries, click the “OK” button to save the exam. 
 

Important note: If LabSoft Manager is open, the exam display will not be updated, even 
though TestCreator will have added the exam to the LabSoft configuration file. This means 
that LabSoft Manager should always be closed when a new exam is created. If Manager 
is open, the option “Do not save changes” needs to be set at closing the Manager 
program to ensure that the entry for the new exam is not lost.  

 
 

6 . 6  T o o l  b a r  a n d  m e n u  i n  T e s t C r e a t o r  
 
 
The tool bar is mainly there for editing the list of questions in the main window, as well as providing 
some general functions. The most common TestCreator functions for editing the selected 
questions are found here. Less common functions can be found in the menu.  
 

 
 
Functions on the tool bar from left to right: 
 

 
 
New:  This opens a new, empty project. The program will then be in the state it 

usually adopts when first run. Within a project you can load multiple 
databases simultaneously as well as setting up filter functions. The “Save” 
command (see below) allows you to save a project under a name of its own 
so that it can be opened again at a later date. 
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Open: Opens a dialog window for opening an existing TestCreator project 

(xxx.tcproj). The project is then loaded into TestCreator along with all the 
databases and filter settings stored in it as well as the questions which have 
already been selected.  

 

 
 
Save: This saves the current settings (databases loaded, filter settings and already 

selected questions in a project. If no project was opened previously, the 
current settings may be saved in a new one. 

 

 
 
Delete: Removes highlighted questions from the list of selected questions. This 

procedure cannot be undone but questions can be copied back into the 
selection by means of drag and drop. 

 

 
 
Up: Moves a selected question one place up in the list. 
 

 
 
Down: Moves a selected question one place down in the list. 
 

  
 
Keep question groups together: This makes it possible for a group of questions selected for a 

exam to be kept together instead of being split up into separate questions. If 
a group is kept together, all the questions will appear contiguously on a single 
page. If the questions are separated, each one will have its own page 
(potentially appearing in random order). Click the icon to activate or 
deactivate the option. 
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Shuffle: This shuffles the questions selected for the exam into a new random order. 
 

  
 
Random test: Opens a dialog window for the questions in the test / exam to be randomly 

selected automatically. Various options can be selected in the window as 
seen before (see section 6.4: Automatic (random) selection of questions for 
an exam). 

 

  
 
Export test: Opens a dialog window for exporting an exam. Various options can be 

selected in the dialog window (see section 6.5: Exporting exams). 
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Other, less commonly used functions can be found in the menu. The most important of these are 
listed and described in brief below. This manual does not provide a detailed description of all the 
available menu options. Detailed descriptions of all options can be found in the help for 
TestCreator (menu Help/Help topics/LabSoft TestCreator) 
 
Edit menu  
 
Delete: Removes highlighted questions from the list of selected questions. This 

procedure cannot be undone but questions can be copied back into the 
selection by means of drag and drop. 

 
Up: Moves a selected question one place up in the list. 
 
Down: Moves a selected question one place down in the list. 
 
Shuffle: This shuffles the questions selected for the test into a new random order. 
 
 
Options menu 
 
Random test: Opens a dialog window for the questions in the test to be randomly 

selected automatically. Various options can be selected in the window as 
seen before (see section 6.4: Automatic (random) selection of questions for 
a test). 
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Export test: Opens a dialog window for automatically selecting a random exam. Various 
options can be selected in the dialog window (see section 6.5: Exporting 
tests). 

 

 
 
 
 
Create printable version...: Opens a dialog window for automatically generating a printable 

version of the exam (paper version) with the selected questions. You can use 
such a printed version for documentary purposes or use for a written test 
(although it will of course be impossible to electronically evaluate the results 
in this case). The test itself is printed out from LabSoft in preview mode. You 
need to specify the following entries in the dialog window as seen below. 
Click “OK” when you are finished. 

 

 
 

Name: Specify a title for the test. This will be shown on the cover page for 
the test. 
 
Destination folder: Click the folder icon  at the end of the entry box to 
specify a folder on the local hard drive or on a network in which to save the 
printable version. 
 
Duration: Enter the time needed to complete the test. This duration will also 
be shown on the test’s cover sheet. 
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Show preview in LabSoft: Set this option if you want to open the new 
printed version in LabSoft immediately or if you want to print it out. 

 
Note: For LabSoft to start up in preview mode like this, it first needs to be 
closed. Preview mode will not start if LabSoft is already running. 
 

 
Open in Questioner: This option causes the question currently selected in the main window to 

be opened in the Questioner program. Questioner can then be used to edit 
or amend the question. When the test is finally put together, the modified 
version of the question will automatically be the one used in it. 

 
Note: A modified question will only be shown in the preview window of TestCreator after it has 
been clicked again in the assignment collections window. Any altered meta data for the question 
will only be shown once it has been dragged back into the main panel. 
 
Keep question groups together: This makes it possible for a group of questions selected for a 

test to be kept together instead of being split up into separate questions. If a 
group is kept together, all the questions will appear contiguously on a single 
page. If the questions are separated, each one will have its own page 
(potentially appearing in random order). Click the menu option to activate or 
deactivate the option. The current status of the option is indicated by the 
appropriate icon on the tool bar. 

  Activated:      Deactivated:    
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7 .  R e p o r t e r  
 
LabSoft Reporter makes it easy to follow the progress of students as they work through the 
individual courses. Test results can be called up and assessed as soon as the test is completed. 
Reporter also offers a variety of different assessment options. 

7 . 1  S t a r t  
 
Start running Reporter from the “Start” menu on your Windows task bar. As long as you did not 
change the settings for the icon to start the program when you installed it, you will find it located 
under the following option: 
 
Start  Programs  Classroom Manager Reporter 
 

 
 
A list box will open from which you can select the language you wish to use. Select the required 
language and click “OK” to confirm it. If only one language has been installed for the program, 
this window will not appear and the program will start running straight away. 
 
Note: You can disable the appearance of the language window by ticking the box labelled “Do not 
show this message again”. Reporter will then start every time in the language you have currently 
set. In order to re-enable the window, you need to hold down the “Shift” key when you start the 
program. 
 
Note: Immediately after the program starts running, Reporter loads the necessary data. 
Depending on the number of users and courses registered, this may take some time. Wait until 
the loading of data has completed. 
 

 
 

Important: Reporter will only start if the supplied USB dongle is plugged into the 
computer’s USB ports. Without the USB dongle, the program will not start and you will get 
the following error message: 
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After Reporter has started running, all the groups registered in the Manager program are 
displayed in the Configuration window. Assessments for individual users, courses or tests are 
then managed on the basis of these groups. The corresponding results are displayed in 
accordance with the selection made in the main window (bottom right in the illustration).  
 

Important: The assessment evaluation logic only works for registered users, i.e. users 
who have been entered under “Users” in LabSoft Manager (see section 3.4 LabSoft 
Manager, Users view).  
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7 . 2  C o n f i g u r a t i o n  w i n d o w  
 
The “Configuration” shows all the groups, users and courses or tests registered in LabSoft 
Manager. You can switch between courses and tests with the help of the icons on the tool bar. 
Information is organised on the basis of the registered groups. 
 

 
 
The tool bar has the following icons: 
 

 
Display courses: Groups users and courses are displayed in the 
configuration window. 

 
Display tests: Groups users and tests are displayed in the configuration 
window. 

 Expand all entries 

 Collapse all entries 

 
Underneath the tool bar is an entry box for searches within the configuration window. When you 
type a search entry, the program automatically searches for the corresponding sequence of 
characters within the configuration window and any matches will then be displayed. You can go 
back to displaying all groups by deleting the search entry or clicking the magnifying glass icon. 
 
Clicking on a group expands its display to include “Users” and “Courses” or “Users” and “Tests”, 
depending on whether the course or test icon on the tool bar has been selected. Clicking the user, 
course or test listings expands them to display the individual users, courses or tests for the group. 
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Note: If the user file or a course/test is not present, this will be indicated by a warning symbol 
in the configuration window. 
 
Clicking “Courses” starts by showing all the courses associated with the group in the main 
window. 
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Selecting a specific user causes their progress in the various courses to be displayed in the main 
window in the form of a list. The two possible colours indicate the percentages of correctly 
answered questions along with the percentage of pages actually visited and the “guess factor”. 
The “guess factor” is the ratio between those questions which required more than one attempted 
answer to those which were answered correctly first time. 
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Selecting an individual course causes the progress for that course made by all users in the group 
to be displayed in the main window. This includes the percentage of time spent on the course, 
the number of pages visited, the number of correct answers and the “guess factor”. The “guess 
factor” is the ratio between those questions which required more than one attempt to those which 
were answered correctly first time. 
 

 
 
If the display has been configured to show tests rather than courses, selecting a user displays his 
results for all registered tests. The lengths of the bars indicate the point scores achieved for the 
individual tests. A white bar means a test that has not yet been taken. If a red bar extends all the 
way across, it means the score achieved on the test was “0%”. 
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Selecting a test shows the results gained in that test by all users in the group. 
 

 
 
 
 
 

7 . 3  D i s p l a y  w i n d o w  
 
In the display window, the main window, results are displayed corresponding to whichever 
selection has been made in the configuration window. The data displayed can be shown in 
ascending or descending order by clicking the relevant column header. The default is to display 
data alphabetically in ascending order according to the name of the course, test or user. 
 
By way of example, the illustrations below show the same assessment data, firstly sorted in 
ascending order by name and secondly in descending order by result. 
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7 . 4  A s s e s s m e n t s  
 
There are three basic views for course assessments and four for assessment of tests. The views 
are selected from the tool bar. The following icons are provided for this: 
 

 

Summary list: This shows a list with all the courses and tests taken by a 
user or a list of all users who have taken a course or test, depending on 
what has been selected in the configuration window (users, courses, 
tests).  

 

Course assessment: This shows a list with the assessment results for all 
the users in a group who have taken a course or test, depending on what 
has been selected in the configuration window (users, courses, tests). If a 
specific user has been selected in the configuration window, the 
assessments for all courses and tests taken by that user will be displayed. 

 

Result list: This shows the results for all the individual courses or tests 
taken by a specific user. In the case of tests, the arrow button can be used 
to display the answers the user gave to the individual questions (detailed 
report). 

 

7.4.1 Course assessment 
 
If a specific course has been selected, the initial display shows a summary list of the results 
achieved by all members of a group on that course. This initial summary shows a results bar for 
each user in the first column of the list. 
 

 
 
The lengths of the bars indicate the students’ progress through the course. Yellow bars indicate 
the percentage of the course pages which have so far been visited by the student and green bars 
indicate the percentage of correctly answered questions. The lengths of the green bars are 
calculated with reference to the overall progress (yellow). 
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The numbers in the other columns have the following meanings: 
 

 
Time during which the user was logged into a course. This is given as 
hours : minutes. 

 
Percentage figure for the number of pages visited so far with reference 
to the total number of pages in the course. 

 
Percentage figure for the number of correctly answered questions with 
reference to the total number of questions appearing in the course. 

 

Guess factor: Percentage of questions where the student required a 
repeat attempt to answer correctly with reference to the total number 
of questions answered. 

 

Switching to the course assessment view  shows an assessment of the results (marks or 
grades) obtained for this course by all group members. These assessments are based on the 
ratio of correctly answered questions to the total number of questions appearing in the course. 
 

 
 
The lengths of the coloured bars refer to the number of students achieving the given assessment 
results with reference to the total number of members in the group. The assessment “0 (NA)” 
indicates those who have not yet started the course. The numbers in the other columns have the 
following meanings: 
 

 
Average time that students achieving this result were logged into the 
course. This is given as hours : minutes. 

 
Number of users who have achieved this result. 
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Average point score for users achieving this result (as a percentage). 

 

Upon switching to the result list view  the display will then show detailed results for the 
individual group members. 
 
Note: The “Extended report” function is inactive for courses. It is only available for tests (see 
following section 7.4.2). 
 

 
 

 
 
The columns serve the following meanings: 
 

 Number of attempts at answering this question 

 Maximum point score achievable for this question 

 Point score achieved for this question 
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At the end of the list, the assessment rating and the total points are also displayed. 
 

 
 

Note: With the help of the arrow buttons on the tool bar  you can also display the results 
for other members of the group. 
 

7.4.2 Test assessment 
 
If a specific test has been selected, the initial display shows a summary list of the results achieved 
by all members of a group on that test. This initial summary shows a results bar for each user in 
the first column of the list. 
 

 
 
The lengths of the coloured bars refer to the results achieved as a percentage of the possible 
score. If the score was 0%, the bar will be coloured red. 
 
The numbers in the other columns have the following meanings: 
 

 Time taken for the test, given as hours : minutes.  
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 Percentage score achieved. 

 
Assessment result achieved (mark/grade). 

 
Note: The way that results are assessed can still be modified even after the test has been taken. 
This is done using the Questioner program. Using the “ ” on the tool bar it is possible to open 
the question database for the selected test in Questioner directly. (For more details see section 
7.5). 
 

Switching to test assessment  shows the grades achieved by the entire group in this test. The 
overall assessments are made on the basis of the percentage of students achieving the given 
results. 
 

 
 
The lengths of the coloured bars refer to the number of students achieving the given assessment 
results with reference to the total number of members in the group. The assessment “0 (NA)” 
merely indicates those who have not yet completed the test. The numbers in the other columns 
have the following meanings: 
 

 Time to take the test, given in hours : minutes. 

 
Number of students who have achieved a given result. 

 
Average point score achieved by students with this result (as a 
percentage). 

 

Switching to the results list  the display then shows detailed results for individual group 
members. 
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For tests there is an alternative detailed report specifying all the answers given by each student. 
Clicking the arrow icon on the results list icon switches to the extended report view. 
 

 
 
Note: This function is only available for tests created with the current version of Classroom 
Manager. It is not possible to display this information for tests created with earlier versions and 
the “Detailed report” field is disabled. 
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Note: With the help of the arrow icons on the tool bar  you can also display the results for 
other members of the group in either view. 
 
If you wish to go back to the display of the results list, click again on the “Extended report” button. 
 

 
 
 

7 . 5  C h a n g i n g  t h e  r u l e s  f o r  a s s e s s i n g  r e s u l t s  
 
As long as no changes are made, Reporter automatically awards grades for courses based on a 
standard grading formula as used by Germany’s Chamber of Commerce and Industry (IHK). This 
formula is included when establishing the database for a test. Results are expressed as a 
percentage and the percentages assigned to grades from 1 to 6, which could be considered 
equivalent to a grading system which runs from A to F. The ranges for the grades can also be 
individually modified. Such modifications are made with the help of the Questioner program. 
 
Select the test for which you wish to change the assessment formula in Reporter and then click 
the Questioner symbol in the top right of the Reporter window. 
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The database used for the test is opened in Questioner. Select “Scoring” from the “Options” 
menu in Questioner. The following window will open. Pressing the "Standard" button will fill in 
the list with the default rules. 
 

 
 
However, the window can also be used to enter your own criteria for how the test is to be 
marked. Reporter will then use these rules when displaying the overall results for the test. 
 
In the "Condition" column of the dialog box, you can enter the logic to be used and in the “Result” 
column, you enter the desired assessment results. Conditions are assessed in order from top to 
bottom. Assessment stops when the first matching condition is reached and the corresponding 
result is then assigned. 
 
You can use the standard values as a template for your own assessment criteria. The following 
options can be used for the assessment results: 
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QUESTIONS Total number of questions

MAX_SCORE Maximum number of points which can be achieved

CORRECT Number of questions answered correctly 

INCOMPLETE Number of questions answered partially correctly 

FAILED Number of questions answered incorrectly 

UNANSWERED Number of questions not answered

SCORE Points (score) achieved

SCORE% The score obtained expressed as a percentage. 
This is SCORE / MAX_SCORE * 100 

MAX_ASCORE Maximum score achievable from all questions 
answered 

ASCORE% Score obtained from those questions answered 
expressed as a percentage. This is equal to SCORE 
/ MAX_ASCORE * 100 

GUESS% "Rate factor". This is the percentage of questions 
answered which required more than one attempt. 

OTHER This is another condition which is applied in all 
cases 

 
 
For purposes of comparison, the following operatives can be used. 
 

< Less than

<= Less than or equal to

= Equal to

> Greater than

>= Greater than or equal to
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In order to check multiple conditions, the following Boolean operators can be used: 
 

AND Carries out an “and” operation. The “&” character 
can also be used as an abbreviation for this. 

OR Carries out an “or” operation. The “|” character can 
also be used as an abbreviation for this. 

NOT This executes a Boolean negation of the following 
value or expression. The “~” character can also be 
used as an abbreviation for this. 

 
 
 

7 . 6  I c o n s  a n d  m e n u  b a r s  i n  R e p o r t e r  
 
 
The tool bar is mainly used for selecting what is to be displayed in the main Reporter window. 
More rarely used functions can be accessed via the menu bar. 
 

   
 
The tool bar includes the following functions: 
 

 
 
Open: This opens a dialog window in which alternative LabSoft configuration files 

can be loaded. By default the program always loads the configuration file 
specified in the registry when it starts running. 

 

 
 
Print: This prints the data currently being displayed in the main window. For tests, 

a complete report with the answers actually given can be printed out. 
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Summary list: This shows a summary list in the main window. The content actually 
displayed depends on what has been selected in the configuration window. 

 

 
 
Results: The results of all members of a group for a course or test are displayed in 

the main window. 
 
 

 
 
Results list: The detailed results for a single user in a single course or test (depending on 

what is selected in the configurations window) are displayed in the main 
window. 

 
 

  
 
Up/Down: These buttons are used to navigate to other entries (users or courses) in a 

list displayed in the main window. For instance if the results list for a course 
is selected, it is possible to switch between the detailed results of different 
users. 

 

 
 
Questioner: This opens the database for the currently active test (course) in Questioner. 

Here you can alter the scale for grading test results. Select “Assessment 
formula” from the “Options” menu in Questioner to do this. In the window 
which then opens, you can change the assessment criteria (see section 7.5).  
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The menu bar also provides access to the following functions. A detailed description of the menu 
options can be found in the help for Reporter (Menu Help/Topics/LabSoft Reporter) 
 
File menu 
 
Open  This opens a dialog window in which alternative LabSoft configuration files 

can be loaded. By default the program always loads the configuration file 
specified in the registry when it starts running. 

 
Page view: This opens a print preview in the main window which contains the currently 

displayed data. 
 
Print: This prints the data currently being displayed in the main window. 
 
 
 
Export: This opens a dialog window for exporting data. Data can be copied to the 

clipboard or exported to a text file (.txt), which can subsequently be 
processed elsewhere (e.g. in Excel). 

 

 
 
Exit: Exits the Reporter program.  
 
 
Settings menu 
 
Display: This opens a dialog box for personalising the display. The colours for 

progress bars and how user names are displayed can all be modified. 
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View menu 
 
This allows display of the configuration window as well as of tool and status bars to be enabled 
or disabled. 
 
Help menu 
 
Topics: This opens the help for the Reporter program.  
 
About: This opens a window which includes the version number of the program 
 

8 .  T a b l e E d i t  p r o g r a m  
 
The TableEdit program allows you to create or modify templates for tables and graphs (*.tvly files) 
for TableView objects (see section 4.4.2: Editing course pages, Insert object). LN TableView 
objects consist of a table of values and a corresponding graph. Measurements can be entered 
into such a table object embedded in a LabSoft course. A graph of the results is then generated 
automatically by switching the object to its so-called “Chart” view. You can switch between “Table” 
and “Chart” views by means of tabs at the bottom edge of the window.  
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8 . 1  R u n n i n g  t h e  p r o g r a m  
 
Open Table Edit using the “Start” button on the Windows task bar. As long as you have not 
changed the path for the program icon during installation, it should appear under:  
 
Start  All Programs  Classroom Manager Editor 
 
 

Important note: The Editor program only starts if the supplied USB dongle is inserted into 
one of the computer’s USB ports. If the dongle is not present, the program will not start 
and the following error message will appear: 
 

 
 
As long as the USB dongle is plugged in the program will start. 
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8 . 2  C r e a t i n g  a  T a b l e V i e w  t e m p l a t e  
 
The following section uses a simple example to describe the basic procedure for creating a 
TableView template (.tvly file). First the basic properties of the table need to be specified. 
 

8.2.1 Creating a table 
 
Click “Properties” in the “Table” menu. The following dialog window opens to let you establish the 
attributes of the table. 
 

 
 
Lines:  Specifies the number of rows the table will have 
 
Columns: Specifies the number of columns the table will have 
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Fixed lines  This specifies a number of “fixed rows” counting from the top of the table, 

which users will not be able to modify. Such rows are designed so that you 
can specify headers for the table columns. 

 
Fixed columns  This specifies a number of “fixed columns” counting from the left of the table, 

which users will not be able to modify.  
 
Fixed column height: Specifies that the top row of a column is a certain height 
 
Grid lines: Sets up a colour for the lines of the table grid 
 
Note: Commonly the first row of a table contains headers specifying the variables to be measured 
and the first column contains a set of values for one variable which are pre-determined in the 
experiment instructions. Since neither of these things ought to be changed, such rows/columns 
need to be declared as being “fixed” after their contents have been determined so that students 
cannot modify them while working through a course. For the purpose of creating/editing a table 
in TableEdit, though, there should not initially be any fixed rows or columns (number set 
to “0”). 
 
First mark all of the table cells with the mouse an select “Unprotect ” from the “Cells” menu. This 
ensures that all the cells in the table can be modified and changed in size. 
 

 
 
The next step is to establish a first row with the variables to be measured. Double clicking 
anywhere on a specific cell allows it to be edited. A subsequent right-click also allows the cell to 
be formatted. You can thereby set the font, alignment and background colour for one or several 
cells. 
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Next you should enter any pre-determined measurement values. These are usually listed in the 
first column of a table. When a graph is plotted later on, these values are represented along the 
x-axis. 
 

 
 

All the cells in the table intended to contain pre-defined values or measurements need to be of 
the type “Number”. For this reason, you should select all the relevant cells and select the option 
“Type - Number” from the “Cells” menu, as shown in the screenshot below. 
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Note: Cells of type “Number” automatically display their contents to two places of decimal. If the 
cell is too small for this, you will only see a line of points in them. To change this, you can either 
increase the width of the cells or reduce the number of decimal places to be displayed. Click on 
the right hand edge of a cell and hold the button down in order to drag the columns wider or 
narrower. To change the way the number is displayed, highlight all the cells in question and right 
click on them to open a context menu, from which you should select the option “Number format”. 
Change the settings as you require and click “OK” when you are finished. 
 

       
 
Once you have finished formatting the table, you should define the rows and columns, which 
should not subsequently be modifiable within the course, as being “fixed”. Select the “Properties” 
option from the “Table” menu and enter the number of fixed rows and columns into the properties 
dialog window that then opens as shown below.  
 

 
 
That should complete the formatting of the table. The next step is to format the associated graph. 
If necessary the table can easily be edited again later on.  
 

8.2.1 Generating a graph 
 
Once a table has been created, it is then possible to design a graph for the results. Click on the 
“Chart” tab at the bottom of the window to switch the program to chart mode. 
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Select “Properties” from the “Chart” menu or double click anywhere on the surface of the graph. 
A dialog window will open in which you can configure how the measured results will be plotted.  
 
 

 
 
This window has five tabs, “Models”, “Scales”, “Grid”, “Zero Lines” and “Font” (for labels on the 
chart). Start on the “Models” tab. If you have been creating a new file, the list of models will initially 
be empty. In order to add a model, click the “New” button. Another dialog box will open, in which 
you need to enter the appropriate settings. Enter a description of the model in the “Name” field. 
This name is intended as a way of easily identifying the model. 
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The name will later be displayed in the list of defined models. Now you should select one of the 
pre-defined model templates from the list of models (see above) and click "OK" to associate it 
with your new model, which is then added to the list in the properties window. You can now specify 
the axes to be associated with specific columns of data.  
 

 
 
The “Source” entry in each case refers to the data in the table. Column 1 is automatically selected 
as the source for the values on the x-axis and Column 2 is used as the source for the y-axis. You 
can change these assignments if your table is laid out differently. 
For the x-axis it is also possible to specify a range of values to be plotted. The “From” field defines 
the row at the top of this range and “To” defines the one at the bottom. If you enter “0” in the “To” 
field, then all the rows will be displayed. 
 
Note: The top line of a table commonly contains headers for the columns. If this is so, you should 
enter “2” in the “From” field to specify the start of the data. 
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Note: You can click the “Properties” button in order to format the line thickness and colour for the 
plotted curve.  
 

 
 
If you want to plot more than one curve, click the “New” button to establish a new model for each 
of those curves. 
 
Now switch to the “Scales” tab. Here you can specify the range of values for the axes and enter 
labels for them. Specify minimum and maximum values for each axis and a size for the divisions 
on the scale (also the separation for the grid on which the graph will be plotted). The “Ticks” box 
allows for sub-divisions to the scales to be specified. 
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Important note: make sure that the range for the scales matches the actual range of the 
measurements. If values in the table are beyond the range of the scales, then those values 
will not appear in the plot.  

 
For the purposes of this example the chart should now be fully specified. 
 

 
 
You can now check that the graph is working properly by entering fictitious values into the table 
and then switching to “Chart” mode to see them plotted in a graph.  
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Note: Switch back to the “Table” view and delete your fictitious values again.  
 

 
 
Now save your new TableView template by choosing “Save” from the “File” menu or clicking the 
floppy disc icon on the tool bar.  
 
Note: The template is saved with a “.tvly” extension. Afterwards you can insert this template into 
a course as an embedded TableView object with the help of the Editor program (see section 4.4.2: 
Editing course pages, “Insert” menu). 
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8 . 3  M e n u  b a r s  f o r  T a b l e E d i t  p r o g r a m  
 
Depending on the view (Table or Chart) a different set of menu options are provided on the menu 
bar. The following list introduces you to the most important menu options. You can find a detailed 
description of all the entries in the menu in the help for the program.  
 

8.3.1 Menu bar in “Table” view 
 
Edit menu  
 
Cut  Cuts out the content of highlighted cells and saves it to the clipboard. 
 
Copy Copies the content of highlighted cells to the clipboard. 
 
Paste Paste content previously cut out or copied to the clip board into the table. 
 
Delete  Deletes the contents of highlighted cells. 
 
Select all: Highlights all the cells in the table. 
 
Insert column: Inserts a column next to the highlighted cell. 
 
Insert line: Inserts a row above the highlighted cell. 
 
Delete column: Delete the whole column containing the highlighted cell. 
 
Delete line: Delete the whole row containing the highlighted cell. 
 
 
Table menu 
 
Properties  Opens a dialog window for modifying table properties 
 
Size to content Automatically sets the dimensions of the table to match the contents in the 

cells. Tip: Use this command only after you have made all the necessary 
entries for the table (and chart).  
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Cells menu  
 
Type  Specifies the type of content in a cell. The possible options are “Text”, “ 

Number” or “Graphic”. For cell contents to be displayed in a graph the cell 
must be of type “Number”. 

 
Align Sets the alignment of text within a cell. The possible options are “Left”, “Right 

or “Center”. 
 
Protect Fixes the specified cell so that it cannot be modified or changed in size. 
 
Unprotect Lifts the prohibition against modifying a cell. 
 
Font: Opens dialog window so that you can define a font for the content of a cell. 
 
Background colour: Opens a dialog window to modify the background for a cell. 
 

8.3.2 Menu bar for “Chart” view 
 
Chart menu  
 
Properties  Opens the “Properties” dialog window. This window allows all the properties 

for the graph to be specified. It has 5 tabs. Under the “Models” tab you can 
specify the way the curves are to be plotted. The “Scales”, “Grid” and “Zero 
axes” tabs are for formatting the graph itself, while the “Font” allows a font to 
be specified for the labelling of the axes. 
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Tip: You can open the Properties dialog window by right-clicking with the mouse anywhere on 
the chart field. Another menu option “Labels” is also added. This allows you to enter any text (tiles 
for a plot of measurements) anywhere on the surface of the graph. 
 
Add axis Adds a new Y-axis to the graph. It is possible to add multiple axes. 
 
Remove axis Removes a Y-axis from the graph. 
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